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S E C T I O N 5 Manage Directories and Files in the 
Linux System

In this section of the workbook, you learn how to do the following:

■ “Mount Removable Media” on 5-2

■ “Change Directories and List Directory Contents” on 5-3

■ “Create and View Files” on 5-5

■ “Copy and Move Files and Directories” on 5-6

■ “Create Directories” on 5-8

■ “Delete Files and Directories” on 5-9

■ “Link Files” on 5-10

■ “Find Files on Linux” on 5-12

■ “Search File Content” on 5-14

■ “Archive Files” on 5-15

■ “Compress and Uncompress Files with gzip and bzip2” on 5-17

Most of the exercises in this Section instruct you to close the 
terminal window at the end of the exercise (in case you do not 
complete the exercises at the same time).

However, if you plan on completing the exercises in one sitting, you 
can ignore the instruction at the end of each exercise to close the 
terminal window.
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Exercise 5-1 Mount Removable Media

In past versions of Linux it was necessary to mount removable 
media with some command to access them and to unmount them 
afterwards. This has been automated in current kernel versions.

To access removable media, do the following:

1. From the KDE desktop, open a terminal window.

2. Log in as root by entering su - with a password of novell.

3. Insert a SLES 9 CD in your CD-ROM drive.

4. (Conditional) If a dialog appears indicating that a data CD was 
found, close the dialog by selecting No.

5. Display the content of the directory /media/cdrom/ by entering

ls /media/cdrom

x If your CD-ROM drive is also a CD recorder, enter
ls /media/cdrecorder

If the CD is mounted automatically, the content of the CD is 
listed; if not, the directory is empty.

6. Mount the CD manually by entering 

mount /dev/cdrom /mnt

x If your CD-ROM drive is also a CD recorder, enter 
mount /dev/cdrecorder /mnt

A message appears indicating that the device is write-protected 
and is mounted as read only.

7. Display the content of the directory /mnt by entering 

ls /mnt
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The content of the CD is listed.

8. Try to remove the CD from the drive by pushing the eject button 
on the drive.

The CD unmounts automatically and the CD tray opens.

9. (Conditional) If the CD tray does not open, unmount the CD 
manually by entering

umount /mnt

Then push the eject button.

10. Remove the CD from your CD drive.

11. Display the contents of the directory /mnt by entering 

ls /mnt

The directory is now empty.

12. Log out as user root by entering exit.

13. Close the terminal window by entering exit.

(End of Exercise)

Exercise 5-2 Change Directories and List Directory Contents

Smooth administration of a Linux system requires familiarity with 
the directory tree and how to move within it. The purpose of this 
exercise is to show you how to orient yourself and move about 
within that tree.

To change the current directory and list the directory contents, do 
the following:

1. Describe what directories the following characters refer to:

❑ /

❑ ~
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The content of the CD is listed.

8. Try to remove the CD from the drive by pushing the eject button 
on the drive.

The CD unmounts automatically and the CD tray opens.

9. (Conditional) If the CD tray does not open, unmount the CD 
manually by entering

umount /mnt

Then push the eject button.

10. Remove the CD from your CD drive.

11. Display the contents of the directory /mnt by entering 

ls /mnt

The directory is now empty.

12. Log out as user root by entering exit.

13. Close the terminal window by entering exit.

(End of Exercise)
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❑ .

❑ ..

2. From the KDE desktop, open a terminal window (Konsole).

3. Change to the directory /tmp/ by entering cd /tmp.

4. Change to the home directory by entering cd ~.

5. Display the name of the current directory by entering pwd.

6. Change to the directory /usr/share/doc by entering

cd /usr/share/doc

7. Display the name of the current directory by entering pwd.

8. Change back to the last directory (home) by entering cd -.

9. Display the name of the current directory by entering pwd.

10. Display the content of the current directory by entering ls.

11. Display the content of the current directory including the hidden 
files by entering ls -a.

12. Display the permissions and the file size of the directories 
starting with “D” in the current directory by entering 

ls -ld D*

13. View the permissions and the file size of all the files in the 
current directory by entering ls -la.

14. Close the terminal window by entering exit.

(End of Exercise)
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Exercise 5-3 Create and View Files

To be able to view configuration and log files is a necessary part of 
system administration. Various tools exist for this purpose, and you 
choose the appropriate one depending on whether you want to view 
the complete file or only part of it.

To create and view files or parts of them, do the following:

You need to create new_file for 
Exercise 5-4 to work properly.

1. Open a terminal window, log in as root (su -) with a password of 
novell.

2. Create a new, empty file by entering 

touch new_file

3. Display the content of the file /var/log/messages by entering

cat /var/log/messages

4. Display the content of /var/log/messages page by page by 
entering 

less /var/log/messages

5. Find the first occurrence of the word “root” by entering /root.

6. Find the next occurrence of the word “root” by typing n.

7. Navigate through the output by using the cursor keys and the 
Page Up and the Page Down keys.

8. Quit the display and return to the command line by typing q.

9. Display the first 5 lines of the file /var/log/messages by entering

head -n 5 /var/log/messages

10. View a continuously-updated display of the last lines of the file 
/var/log/messages by entering 

tail -f /var/log/messages

11. Open a second terminal window.
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12. Arrange the terminal windows on the desktop so that you can see 
the content of both.

13. In the second terminal window, log in as root (su -); then enter an 
invalid password (such as suse).

Notice that the failed login attempt is logged in the first 
terminal window.

14. In the second terminal window, log in as root (su -) with a 
password of novell.

The login is logged in the first terminal window.

15. Log out as root in the second terminal window by entering exit.

16. Close the second terminal window by entering exit.

17. Stop the tail process in the first terminal window by pressing Ctrl 
+ c.

18. Log out as root by entering exit.

19. Close the terminal window.

(End of Exercise)

Exercise 5-4 Copy and Move Files and Directories

Copying, moving and renaming files are basic and frequent 
operations done with files. Most probably you are already very 
familiar with these operations on a graphical desktop environment.

The purpose of this exercise is to get used to performing these 
operations on the command line. 

To copy and move files and directories, do the following:

You need to complete this 
exercise for the rest of the 
exercises in Section 5 to work 
properly.

1. Open a terminal window and log in as root (su -) with a password 
of novell.

2. Rename new_file to my_file by entering 
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mv new_file my_file

3. Verify that the file was renamed by entering ls -l.

4. Copy my_file by entering cp my_file my_file1.

5. Verify that my_file1 was created by entering ls -l my*.

6. Copy the files /usr/bin/rename and /usr/bin/mcopy to the 
directory /tmp/ by entering

cp /usr/bin/rename /usr/bin/mcopy /tmp

7. Verify that the files were copied by entering

ls -l /tmp

8. Move the file /tmp/mcopy to the home directory by entering

mv /tmp/mcopy ~

9. Verify the move by entering ls -l.

10. Move and rename the file /tmp/rename to ~/my_file2 by entering

mv /tmp/rename ~/my_file2

11. Verify that the file my_file2 exists by entering ls -l.

12. Copy the complete directory /bin/ to the home directory with the 
new directory named my_dir by entering

cp -r /bin /home/my_dir

13. Verify that the files were copied by entering 

ls -l /home/my_dir

14. Close the terminal window.

(End of Exercise)
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mv new_file my_file

3. Verify that the file was renamed by entering ls -l.

4. Copy my_file by entering cp my_file my_file1.

5. Verify that my_file1 was created by entering ls -l my*.
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directory /tmp/ by entering
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14. Close the terminal window.

(End of Exercise)
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Exercise 5-5 Create Directories

The purpose of this exercise is to show you how to create 
directories.

To create directories, do the following:

You need to complete this 
exercise for the rest of the 
exercises in Section 5 to work 
properly.

1. Open a terminal window and su to root (su -) with a password of 
novell.

2. Create a directory named new_dir inside the directory my_dir by 
entering 

mkdir /home/my_dir/new_dir

3. Verify that the directory was created by entering

ls /home/my_dir

4. Create a directory new_dir that includes a new directory 
empty_dir by entering 

mkdir -p ~/new_dir/empty_dir

5. Verify that new_dir was created by entering ls.

6. Verify that empty_dir was created by entering 

ls new_dir

7. Close the terminal window.

(End of Exercise)
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Exercise 5-6 Delete Files and Directories

The purpose of this exercise is to show you how to delete files and 
directories on the command line. 

When deleting files and directories it is especially important to 
work only with the permissions necessary for the task and not as 
root, if possible. As root, you can easily destroy your installation 
with the rm command, and there is no undelete in Linux.

Think twice before hitting enter on an rm command issued as root!

To delete files and directories, do the following:

1. Open a terminal window and su to root (su -) with a password of 
novell.

2. Try to remove the directory ~/new_dir by entering

rmdir new_dir

A message is displayed indicating that the directory cannot be 
removed. This is because the directory is not empty.

3. Remove the directory ~/new_dir/empty_dir by entering

rmdir new_dir/empty_dir

4. Verify that the directory /empty_dir has been removed by 
entering 

ls new_dir

5. Remove the directory ~/new_dir by entering 

rmdir new_dir

6. Verify that the directory was removed by entering ls.

7. Remove the file /home/my_dir/login by entering

rm /home/my_dir/login

8. Verify that the file has been removed by entering

ls /home/my_dir/login
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9. Remove all files with names that begin with “a” in the directory 
/home/my_dir/ by entering 

rm -i /home/my_dir/a*

10. Confirm every warning by entering y.

11. Remove the directory /home/my_dir/ including its content by 
entering 

rm -r /home/my_dir

12. Verify that the directory has been removed by entering

ls /home/

13. Close the terminal window.

(End of Exercise)

Exercise 5-7 Link Files

Links are very convenient in administration, as they help to avoid 
having different versions of the same file within the file system. 

The purpose of this exercise is to learn how to set hard and 
symbolic links and know the difference between those two.

To link a file, do the following:

1. Open a terminal window and su to root (su -) with a password of 
novell.

2. Enter the following to create a symbolic link to the howto index 
file in the directory /usr/share/doc/howto/en/html:

ln -s /usr/share/doc/howto/en/html/index.html howto-sym

3. Enter the following to create a hard link to the howto index file 
in the directory /usr/share/doc/howto/en/html:

ln /usr/share/doc/howto/en/html/index.html howto-hard
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9. Remove all files with names that begin with “a” in the directory 
/home/my_dir/ by entering 

rm -i /home/my_dir/a*

10. Confirm every warning by entering y.

11. Remove the directory /home/my_dir/ including its content by 
entering 

rm -r /home/my_dir

12. Verify that the directory has been removed by entering

ls /home/

13. Close the terminal window.

(End of Exercise)

Exercise 5-7 Link Files

Links are very convenient in administration, as they help to avoid 
having different versions of the same file within the file system. 

The purpose of this exercise is to learn how to set hard and 
symbolic links and know the difference between those two.

To link a file, do the following:

1. Open a terminal window and su to root (su -) with a password of 
novell.

2. Enter the following to create a symbolic link to the howto index 
file in the directory /usr/share/doc/howto/en/html:

ln -s /usr/share/doc/howto/en/html/index.html howto-sym

3. Enter the following to create a hard link to the howto index file 
in the directory /usr/share/doc/howto/en/html:

ln /usr/share/doc/howto/en/html/index.html howto-hard
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4. Display the links by entering ls -l.

Notice that the symbolic link identifies the file it is linked to.

5. View the contents of the file 
/usr/share/doc/howto/en/html/index.html by entering

cat howto-hard

6. Create a file named hello by entering

echo hello > hello

7. Create a symbolic link to the file by entering

ln -s hello hello-symlink

8. View the content of the file hello via its symbolic link by entering

cat hello-symlink

9. Delete the original file by entering rm hello.

10. View the link by entering 

ls -l hello-symlink

Note that the link is now highlighted to indicate that it points to 
a non-existant file.

11. Delete the link by entering

rm hello-symlink

12. Close the terminal window.

(End of Exercise)
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Exercise 5-8 Find Files on Linux

With around 100,000 files in a usual installation it is essential to be 
able to find files effectively within the file system. It is possible to 
search using part of the file name, but also to look for files that 
contain a certain string, as covered in the exercise after this one.

Kfind is not relevant for CompTIA’s 
Linux+.

To find files and directories, do the following:

1. Open a terminal window (you do not need to su to root).

2. Find the type of the command ll by entering type ll.

3. Find the manual pages of the command find by entering

whereis -m find

4. Find the path of the program KFind by entering 

which kfind

5. Start KFind by entering kfind &.

A Find Files dialog appears on the KDE desktop.

6. Find all files in the home directory whose names start with “my” 
by entering my* in the Named field; then select Find.

7. Find all files in the directory /bin/ whose names consist of 2 
characters by entering ?? in the Named field and /bin in the Look 
in field; then select Find.

8. Find all files in the directory /tmp/ that were changed or created 
in the last 24 hours by doing the following:

a. Enter * in the Named field and /tmp in the Look in field.

b. Select the Properties tab.

c. Select Find all files created or modified.

d. Select during the previous; then enter 24 in the text field.

e. Select Find.

9. Close the Find Files dialog.
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10. From the terminal window command line, find all files in the 
home directory whose names start with “my” by entering

find ~ -name “my*”

11. Find all files in the directory /tmp/ that were changed or created 
in the last 24 hours by entering

find /tmp -ctime -1

12. Su to root (su -) with a password of novell.

13. Install the locate utility by entering 

yast -i findutils-locate

and inserting the appropriate SLES 9 CD when prompted.

14. Create the locate database by entering updatedb.

Notice that the updatedb utility also searches for any files 
located on your cdrom or floppy drive to add to the database.

15. When the database is updated, find all files in your file system 
whose names contain the string “my” by entering 

locate my

16. Log out as root by entering exit.

17. Close the terminal window by entering exit.

(End of Exercise)
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Exercise 5-9 Search File Content

Sometimes all you know is some string that appears within a certain 
file, but you do not know in which file exactly. The purpose of this 
exercise is to show you how to find such a file.

To search file content, do the following:

1. Open a terminal window.

2. Find all HTML headings of hierarchy 2 in the file 
/usr/share/doc/release-notes/RELEASE-NOTES.en.html by 
entering (on one line)

grep  "<H2>" 
/usr/share/doc/release-notes/RELEASE-NOTES.en.html

3. Find all locations in the HTML files of the directory 
/usr/share/doc/packages/cups/ that include the word 
“management” by entering

grep management /usr/share/doc/packages/cups/*.html

4. Find all locations in the HTML files of the directory 
/usr/share/doc/packages/cups/ that include lines beginning with a 
number by entering

egrep  “^[0-9]”  /usr/share/doc/packages/cups/*.html

5. Find all locations in the HTML files of the directory 
/usr/share/doc/packages/cups/ that include lines beginning with a 
four digit number by entering

egrep  “^[0-9]{4}”  /usr/share/doc/packages/cups/*.html

6. Close the terminal window.

(End of Exercise)
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(End of Exercise)
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Exercise 5-10 Archive Files

Files are frequently put into archives as they then can be sent more 
easily as attachements to e-mails. Backups also often make use of 
archives. 

Various tools exist for this purpose in Linux and the purpose of this 
exercise is to show you the more common ones.

To archive files, do the following:

You need to complete this 
exercise for Exercises 5-11 to 
work properly.

1. Start the Ark utility from the KDE menu by selecting 

Utilities > Archiving

An Ark dialog appears on the KDE desktop.

2. From the dialog, create a new archive by doing the following:

a. Select File > New.

A Create New Archive - Ark dialog appears.

b. Change to the geeko home directory by selecting the up 
arrow button once.

c. In the Location field, enter unzipped_file.

d. From the Archive format drop-down list select Tar Archive.

e. Select Save.

3. Copy all the files in the directory /bin to the tar archive by doing 
the following:

a. Start Konqueror by selecting the icon in the Kicker.

b. Display the files in directory /bin.

c. Select all files in the directory by selecting 

Edit > Selection > Select All 

(or press Ctrl + a).

d. Copy the files in the directory /bin to the Ark window by 
dragging and dropping the files.

e. Close the Konqueror window.
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4. From the Ark dialog, select File > Quit; then select Save (twice).

5. Open a terminal window (do not su to root).

6. Create a zipped archive of the same files at the command line by 
entering 

tar czvf zipped_file.tar.gz /bin

7. Start Konqueror by selecting the blue house icon in the Kicker.

8. Select the icon of the file zipped_file.tar.gz.

9. Select the bin directory icon.

10. View the navigation area by selecting the red folder icon at the 
left side of the Konqueror window.

11. Copy the file df to the directory /tmp by using drag-and-drop.

12. Close the Konqueror window.

13. From the terminal window, copy the file unzipped_file.tar to the 
directory /tmp by entering 

cp unzipped_file.tar /tmp

14. Switch to the directory /tmp by entering cd /tmp.

15. Verify that the file was copied by entering ls -l un*.

16. Extract the files of the archive /tmp/unzipped_file.tar by entering

tar xvf unzipped_file.tar

17. Switch to the home directory by entering cd -.

18. Close the terminal window.

(End of Exercise)
Workbook 5-16 Copyright © 2007 Novell, Inc. Copying or distributing all or part of this manual is protected by Version 1
a Creative Commons Attribution-NonCommercial-ShareAlike 2.5 license.



Getting Started with Linux: Novell’s Guide to CompTIA’s Linux+ / Self-Study Workbook
 

4. From the Ark dialog, select File > Quit; then select Save (twice).

5. Open a terminal window (do not su to root).

6. Create a zipped archive of the same files at the command line by 
entering 

tar czvf zipped_file.tar.gz /bin

7. Start Konqueror by selecting the blue house icon in the Kicker.

8. Select the icon of the file zipped_file.tar.gz.

9. Select the bin directory icon.

10. View the navigation area by selecting the red folder icon at the 
left side of the Konqueror window.

11. Copy the file df to the directory /tmp by using drag-and-drop.

12. Close the Konqueror window.

13. From the terminal window, copy the file unzipped_file.tar to the 
directory /tmp by entering 

cp unzipped_file.tar /tmp

14. Switch to the directory /tmp by entering cd /tmp.

15. Verify that the file was copied by entering ls -l un*.

16. Extract the files of the archive /tmp/unzipped_file.tar by entering

tar xvf unzipped_file.tar

17. Switch to the home directory by entering cd -.

18. Close the terminal window.

(End of Exercise)
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Exercise 5-11 Compress and Uncompress Files with gzip and bzip2

Usually files are not just put into archives, but they are compressed 
as well to save on bandwidth and/or storage capacity.

To compress and uncompress files, do the following:

1. Open a terminal window.

2. Copy the file 

/usr/share/doc/release-notes/RELEASE-NOTES.en.html 

to the home directory by entering (on one line)

cp
/usr/share/doc/release-notes/RELEASE-NOTES.en.html  ~

The tilde (~) indicates to copy the file to the home directory.

3. Verify that the file was copied by entering

ls RELEASE-NOTES.en.html

4. Compress with gzip the file RELEASE-NOTES.en.html by 
entering

gzip RELEASE-NOTES.en.html

5. Verify that the file was compressed by entering ls.

Notice that the file RELEASE-NOTES.en.html.gz has replaced 
RELEASE-NOTES.en.html.

6. Display the content of the file RELEASE-NOTES.en.html.gz by 
entering

zcat RELEASE-NOTES.en.html.gz

7. Decompress the file RELEASE-NOTES.en.html.gz with gunzip 
by entering

gunzip RELEASE-NOTES.en.html.gz

8. Verify that the file was decompressed by entering ls.
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Notice that the file RELEASE-NOTES.en.html has replaced 
RELEASE-NOTES.en.html.gz.

9. Compress the file unzipped_file.tar in the geeko home directory 
using bzip2 by entering

bzip2 unzipped_file.tar

10. Compare the size of the files unzipped_file.tar.bz2 and 
zipped_file.tar.gz by entering

ls -l  *zipped_file.tar.*

11. Close the terminal window.

(End of Exercise)
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